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Please note 

�� Screenshots used in this manual may appear different to those on computer screens used by 
participants; variations in versions of the software and differing operating systems may be in 
use.

�� The World Wide Web is constantly evolving and content and URLs (Universal Resource 
Locators - website addresses) change over time. It is possible that the content located at 
some of the URLs listed throughout this manual may change over time. 

�� Screenshots and software titles used throughout the manual are from a PC using Microsoft 
Windows XP©. 

�� Participants using other operating systems may encounter some differences in screen 
presentation and layout. 

Throughout this module reference may be made to software titles and suppliers of Internet services. 
These references are made purely to illustrate or expound course content. Any such reference does not 
imply any endorsement by the NCTE of a product or company. The reader should be aware that 
typically there are many products and companies providing similar services in areas related to ICT. 
Participants should be as informed as possible before making decisions on purchases of ICT products or 
services.
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Introduction 

Modern school networks provide students with the world on their desktops.  Keeping students on 
message while using computers in labs can be a daunting task and any help available in this task is 
welcome.   

Classroom management software has two main functions: 

�� Screen sharing:  This is used to enhance the learning experience.  Teachers can  
    observe student screens and also take control of them to demonstrate 
    assignment procedures etc. 

�� User controls:  These are used to guide the learning experience.  Teachers can use 
    these controls to manage student behaviour when using computers. 

Classroom management software will typically allow: 

�� Demonstrations from the teachers computer to student computers 
�� Annotating demonstrations from the teachers computer 
�� Remote control of student computers from the teachers computer 
�� Monitoring of student computers in real time 
�� Communication between students and the teacher with chat sessions
�� Controlling the applications that can run on student computers 
�� Controlling Internet access on student computers 

AB Tutor Control fulfils all these requirements.
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Part 1 

Installation

AB Tutor Control 
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Installing AB Tutor Control 

AB Tutor Control is available from the AB Consulting website at: 

http://www.abtutorcontrol.com/html/download.html 

An online form must be submitted and you will be emailed the download instructions.   

Version 6 is the current version.

A number of checks must be made to ensure the proper installation and operation of the software: 

�� The computers must be on a working network 
�� Administrative rights must be available on the teacher and student computers to install the 

software
�� The teachers computer must have an Internet connection to activate and update the software 

The downloaded abtcsetup6.msi file can be used to install the Tutor program or the Client program.

Installing the Tutor Program 

�� Double-click the abtcsetup6.msi file.  The welcome screen appears 
�� Click Next
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�� The License Agreement screen appears. Click the I accept the terms ….    radio button 
�� Click Next

�� Click the AB Tutor Control radio button.

As this is the teacher computer, the tutor control version is required.  It is possible to install the Tutor
control and the Client versions on a teacher computer, but its only really useful if there will be more 
than one computer lab and more the one teacher computer   
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�� Click Next in the installation folder window

�� Enter a secure password of up to 16 characters in the Password field and the same
password in the Re-type Password field.

This password will also be used when installing the software on the client computers.  Otherwise, you 
will not be able to connect to them.   

�� Click Next
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�� Click the Yes - install the Mirror Driver  radio button 

This Mirror Driver works with the computers display driver.  It controls the mirroring of the teacher 
display on the student computers.  AB Tutor Control will operate without the Mirror Driver, but using 
the Mirror Driver greatly improves the mirroring speed. 

�� Click Next

�� Click Next to begin the installation 
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�� The software is installed onto the teacher computer 

�� Click Finish to complete the installation 

�� An AB Tutor Control icon appears on the Desktop of the Teacher computer 
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Installing the Client Program 

The Client version of the software must be installed on all the student computers in the computer lab. 
This can be done by copying the installation file to a USB Memory Key and using the key to install the 
software on the student computers.  Alternatively, a shared folder can be created on the network  to
hold utilities.  It this shared folder is mapped to an administration level account, the installation file 
will be available in the mapped folder when you log on to the student computers using this account.   

�� Double-click the abtcsetup6.msi file.  The welcome screen appears 
�� Click Next

�� The License Agreement screen appears. Click the I accept the terms ….    radio button 
�� Click Next
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�� Click the AB Client Option radio button.

�� Click Next in the installation folder window

�� Enter the same password used for the AB Tutor Control program 
�� Click Next
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�� Click the Yes - install the Mirror Driver  radio button
�� Click Next

�� The software is installed onto the teacher computer 

�� Click Finish to complete the installation.   
�� No Desktop icons are created with the client install.
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Activating the AB Tutor Control Software 

The downloaded version of the software is fully functional but it times out after 30 days.  When the 
software is purchased  -  by purchase order, credit card etc  -  an Account Serial Number is emailed and 
this is used to activate the software: 

�� Start AB Tutor Control 
�� Click the Tools menu and select License Activation

�� Enter the code in the field as shown below.   
�� Enter a name for the license.  The name of the teacher computer will automatically be 

entered here but it can be changed. 
�� Click Activate

�� The software is activated.  The software no longer shows the Trial screen at start-up.

Enter the Account serial Number here 
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Part 2 

Configuration

AB Tutor Control 
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Configuring AB Tutor Control 

There are a number of settings you may want to change in AB Tutor Control: 

�� Start AB Tutor Control 
�� Click the Tools menu and choose Settings.

A dialog box opens.  There is a number of categories along the left side of the dialog box.

The General category is first up.  Options include: 

�� Scanning for client computers at program start-up.   
�� Automatically connecting to clients  -  this is off by default 

The View/Show category has two very important settings that should be changed:

�� Optimize Remote Client Desktop for best performance 
�� Use Video Driver 
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The Lock Computer category allows you to set the message shown on screen if a client computer is 
locked by the teacher  

The Passwords category allows the setting of the Tutor and the Administrator passwords.  These 
should be different as the administrator password allows full control of the tutor program.  The tutor 
password allows the necessary features to control the client computers, but not to change settings etc. 

The System Messages category allows you set messages which will appear on student screens when
they have been blocked from carrying out an action due to a policy restriction.
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Connection Security Settings 

�� Click the Tools menu and choose Connection Security

There are two very important settings here:   

�� Prevent the ABClient Service from being Stopped.  If this service is stopped on a client 
computer, the tutor computer can’t connect to it. 

�� Prevent the ABClient from being uninstalled via Add/Remove Programs 
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Part 3 

Using AB Tutor 

AB Tutor Control 

Licensed to:  John 
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Using AB Tutor Control 

Starting AB Tutor Control 

�� Double-click the AB Tutor Control icon on the Desktop  If no passwords are set for 
Tutor or Administrator access, the following dialog box appears: 

�� Click OK to enter complete start-up 

�� If passwords have been set in the configuration, the following dialog box will appear: 
�� Enter a Tutor or Administrator password in the field provided 
�� Click the OK button

�� The software starts up and you are presented with the control interface 

Licensed to:  John 

Licensed to:  John 
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The Interface 

The interface changes depending on whether you logged into the software as an Administrator or as a 
Tutor.  The Administrator interface is shown below.

�� Menu bar: Categorised drop–down menus containing all the commands and the 
configuration options

�� Tool bar:  The toolbar contains the most commonly used commands.  The toolbar 
   can be customised to hold different commands.  It can be toggled on and 
   off using the View menu 

�� Main Window: Shows the student computers found by the search utility.  It also shows 
   the connection status of the found computers. It shows what applications 

they are currently running and if any policies have been applied to them.  
   The View menu controls how the icons are displayed. 

�� Tab bar:  Icons to show Thumbnail views of selected computers, Polling to send 
simple questions to students, Event violations and Administration tools.

�� Status Window: Shows status information such as error messages about the connected 
   computers.   

�� Status bar:  Shows the number of found computers and the number of connected 
computers.  Also shows the date and time.

Menu Bar 

Tool Bar 
Tab Bar 

Status Bar Status Window 

Main Window 
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Icons in the Main Window change to show the status of the student computers:

�� The grey screen shows the computer is found, but not connected 
�� The blue screen shows the computer is connected, but no user is logged on 
�� The green screen shows the computer is connected and a user (John) is logged on 
�� The window also shows what applications user John is currently using: 

�� SolidWorks
�� Microsoft Publisher 
�� Mozilla Firefox  
�� Nero Burning Rom 

The Tutor interface is almost identical to the administrator interface, except for the following: 

�� The Groups tab is missing from the Menu bar
�� The Tools tab is missing from the Menu bar
�� The Administrator icon is missing from the Tab bar
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Part 4 

Managing the Main Window 

AB Tutor Control 
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Managing the Main Window 

The Find command 

The contents of the Main Window remains static, even if computers are turned on or off during the 
session.  The status of computers turned off will change, but they will not be removed from the main 
window list.  Computers turned on during a session will not be found.   

The Find command is used to refresh the list and Add any new computers found. 

�� Click the Find command on the Tool bar, or
�� Select the Computers menu and choose Find from the drop-down list 

�� The Search utility scans for new computers 

�� The list is updated in the Main Window
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The Remove command 

Computers turned off remain on the Main Window list.  To remove a computer or computers from the 
list in the main Window: 

�� Select the required computer or computers in the main window 

�� Select the Computers menu and choose Remove from the drop-down list.  The computer is 
removed from the list. 

The Connect command 

This command connects found computers 

�� Select the computer or computers to be connected. 
�� Click the Connect command in the Tool bar, or 
�� Select the Computers menu and choose Connect from the drop-down menu 

�� The computer is connected 
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Groups

If you have only one computer lab, groups are not important.  If, however, there are more computer 
labs in the school, the search utility will find any computer with a client program installed.

Groups allow you to control the selection of client computers.  They can be separated into classroom
groups, each controlled by a tutor program.   

When the Search utility or the Find command is operated, a dialog box appears.  This dialog box 
allows the tutor to select the required group from a drop down list.

Only the client computers added to the chosen group will be found in the search.  This makes the 
administration of multiple computer labs a much easier task.   

The All option is only available when an Administrator logs in.  This allows all the client computers to 
be found for group maintenance etc.

Creating a Group 

�� Log in as an Administrator

Licensed to:  John 



Page 27 

�� In the Main window, select the client computers required for the group 
�� Select the Group menu from the Title bar
�� Choose Add to New Group

�� Open the Group Manager
�� Right-click the new group and choose Edit
�� Name it DCG Room

The DCG Room group shows the client computers belonging to the group in the Members area.

�� Log on with a Tutor account.  Only the computers added to the group are available  
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The Power On command 

It is possible to power on computers using AB Tutor Control.  The student computers must 
be setup to allow the management software start them.   

A setting in the computer’s system setup (BIOS) must be enabled.  This is usually found in the Power 
Management section and is called Wake On LAN.

Next,  As the search utility will not find computers that are powered off, the computers must be added to 
a Group.  They can then be seen even if they are powered off.   

�� Select the student computer/computers you want to power on in the Main Window
�� Select the Computers menu and choose Power On from the drop-down list 

�� The computer now needs to be connected.   
�� Select the computer/computers in the Main

Window
�� Click the Connect button in the Tool bar, or
�� From the Computers menu, click Connect
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The Logon command 

Some teachers may use a common user account for all students.  If this is the case, all 
the computers can be logged on at the same time.  It is also useful for Administrators  
who log on to student computers to install software or perform maintenance. 

�� Select the required computer/computers in the Main Window
�� Click the Logon button in the Tool bar, or 
�� Choose Logon from the Command menu

�� Enter a Username and Password and click the Logon button 

The Logoff command 

At the end of a session, students frequently forget to log off from their computers.  This 
command is very useful for logging off all the computers if necessary. 

�� Select the required computer/computers in the Main Window
�� Click the Logoff button in the Tool bar, or 
�� Choose Logoff from the Command menu
�� A warning message appears on the student screens.  The time to logoff can be set at the 

bottom of the dialog box 
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The Reboot command 

After installing software etc. on student computers, it is advisable to Reboot them.  The  
reboot command allows all the student computer be rebooted at the same time if necessary 

�� Select the required computer/computers in the Main Window
�� Click the Reboot button in the Tool bar, or 
�� Choose Reboot from the Command menu
�� A warning message appears on the student screens.  The time to reboot can be set at the 

bottom of the dialog box 

The Shutdown command 

At the end of the teaching day, it is very useful to be able to power off all the computers at  
the same time.   

�� Select the required computer/computers in the Main Window
�� Click the Shutdown button in the Tool bar, or 
�� Choose Shutdown from the Command menu
�� A warning message appears on the student screens.
�� The time to shutdown can be set at the bottom of the dialog box 
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Part 5 

Screen Sharing 

AB Tutor Control 
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Screen Sharing 

AB Tutor Control has extensive facilities for sharing screens.  These include: 

�� Teacher can watch student screen or screens as required 
�� Teacher screen can be shown on a student screen or screens 
�� Annotating the screen while demonstrating to students 
�� Exhibit a student screen to other students 
�� Send text messages to student computer or computers 
�� Send files to student computers 
�� Collect files from student computers 

A Watch Session 

The teacher can watch student computer screens in real time.   

�� Select the computer/computers you want to watch in the Main Window
�� Click the Watch button in the Tool bar, or 
�� Select the Command menu and choose Watch/Control in the drop-down list 

�� The student computers are arranged as Thumbnails on a Grid on the screen 
�� A control toolbar is included in the screen 
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�� The Cycle option automatically cycles through the selected screens using a time interval set
in the Settings menu 

�� The Grid option returns you to Thumbnails of all the selected screens 
�� The Shared option allows the teacher share control of the currently viewed student

computer with the student 

�� The Lockout option locks the students keyboard and mouse during the sharing. It is a toggle 
�� The Chat option allows you to sent and receive text messages with the selected student 

computer or computers 

�� The Capture option captures the current screen as an image and saves it to a folder
�� The Resize option toggles between full screen and a window on screen 
�� The Close option ends the Watch session
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A Show Session 

A teacher can use this feature to Demonstrate to a selected number of student computers  
or to a complete computer lab.    

�� Open AB Tutor Control 
�� Select the computer/computers you want to Show to in the Main Window
�� Click the Show button in the Tool bar, or 
�� Select the Command menu and choose Give Demo in the drop-down list 

The AB Tutor Control window is Minimized to the Taskbar during the show session.  Clicking the 
minimized icon in the Taskbar will end the show session.

�� What is seen on the students screen can be controlled when the watch session is started.
You can select Full Screen, which locks the students keyboard and mouse,  or Thumbnail
view, which allows the students continue working while watching the demonstration.

�� The students can control the position and size of the thumbnail window
�� The Pushpin at top-right in the thumbnail view is used to ensure the thumbnail window 

stays on top of other applications 
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Annotation a Show Session 

Screen annotating is a useful facility during a show session.  As the AB Tutor Control window is 
minimized during a show session, the annotation feature is started from the System Tray.

�� Click the AB Tutor Control icon in the system tray
�� Select Enable Annotation in the pop-up menu  (you can also Disable Annotation here) 

�� The Annotate Toolbar appears on screen.

�� Line:  Used to draw straight lines on screen in the current colour and width 
�� Ellipse:  Used to draw ellipse shapes on screen in the current colour and width 
�� Rectangle:  Used to draw rectangular shapes on screen in the current colour and width 
�� Draw:  Used to draws freehand shapes on screen in the current colour and width 
�� Lock:  Locks the tool in use so multiple lines or shapes can be drawn 
�� Erase:  Erases drawn objects 
�� Clear:  Clears all drawn objects from the screen
�� Colour: Select the colour of the drawn objects 
�� Fill:   Set to no fill to draw hollow shapes, or to a colour to draw filled shapes 
�� Width:  Sets the width of the drawn objects 
�� Close:  Closes the annotate toolbar and clears all drawn objects from the screen 
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An Exhibit Session 

Exhibit is used to show a students screen on other students screens.

�� Select the computer you want to Exhibit in the Main Window
�� Select the Command menu and choose Exhibit in the drop-down list 

�� Select the student computer/computers you want to exhibit to and click Start

�� A Show session starts and the Show Toolbar is available.  The teacher sees the exhibited 
screen and can Take Control, Annotate etc. 
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Transfer Files 

The teacher can use this facility to send files to student computers.    

�� Select the computer/computers you want to Transfer Files to in the Main Window
�� Select the Command menu and choose File Transfer in the drop-down list 

�� Navigate the Explorer window to find the files/folders you want to transfer
�� Select the Destination Drive or Folder
�� Drag the files/folders as shown below 

�� The files/folders are transferred to the chosen destination

�� The transfer can be in either direction
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Collect Files 

The teacher can use this facility to collect files from student computers.    

�� Select the computer/computers you want to Collect Files from in the Main Window
�� Select the Command menu and choose Collect Files in the drop-down list 

�� Type the file types to be collected in the Collect Files field.  (*.* implies all files)  You can 
list more than one file type, separated by a semicolon.

�� Next, type in the Path to the folder you want searched  e.g. D:\Solidworks
�� Next, type in the folder on the teacher computer where you want the files saved to
�� Click the Get File Listings button at the bottom of the dialog box 
�� Un-tick any unwanted files from the found list  
�� Click the Collect Files button at the bottom of the dialog box.   

�� Ticking the Delete Remote files box deletes the files from the student computers as they are 
copied to the teacher computer. 

Note: There are 2 variables that can be used for specifying Remote Folders: 

�� %desktop%  and %mydocuments%
�� Examples:  %desktop%\solidworks  - %mydocuments%\exercises  etc.
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Part 6 

Controlling Users 

AB Tutor Control 
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Controlling Users 

User controls are used to guide the student learning experience.  Teachers can use  these controls to 
manage student behaviour while using computers. 

Lock 

The Lock command disables the keyboard and mouse on the selected student computers and 
displays a message on their screens 

�� Select the computer/computers you want to Lock in the Main Window
�� Click the Lock icon in the Tool bar, or
�� Select the Command menu and choose Lock

�� The student computers are shown as locked in the Main Window

What is displayed on the students computer screens is set by the Administrator: 

�� Select the Tools  menu and choose Settings
�� The Show Text  option allows you to set a message to be displayed on the students 

computer screens.  Attention Please is the default message, but this can be changed 
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�� The message colour can be changed by clicking the Font button and setting the colour

�� The colour of the background can be set from a drop-down list.  The default colour is
White, but Transparent must be set if you want to set an image and text

�� An image can also be shown. In this case it is a school crest and it is stretched to fill the 
student screens 

�� Click the button as shown below and navigate to the image you want displayed 

Unlock 

The Unlock command unlocks student computers which were previously locked 

�� Select the computer/computers you want to Unlock in the Main Window
�� Click the Unlock icon in the Tool bar, or
�� Select the Command menu and choose Unlock

�� The selected student computer is unlocked
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Thumbnail View 

Thumbnail view is a very useful feature for monitoring student computers.  It allows you 
group student computers into Named Tabs for monitoring.  The monitoring is not in Real Time as in a 
Watch session.  Instead, the thumbnails are Refreshed at an interval set by you.  As a result, it uses 
much less network bandwidth.

�� To start Thumbnail view, click the Thumbnail view icon in the Tab bar
�� To turn off Thumbnail view, click the Main View icon in the Tab bar

Create a new Tab 

�� Right click an existing tab in thumbnail view, select Add New and press the Return key on
the keyboard

Edit a Tab 

�� Right-click an existing tab and select Edit
�� Type the tab name and press the Return key on the keyboard
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Thumbnail Size 

�� The size of the thumbnails can be set by clicking the Size drop-down list at the bottom of
the thumbnail view window 

�� The thumbnails can be set to Small, Medium or Large

Refresh Interval 

�� The refresh interval can be set at the bottom of the thumbnail view window

Adding Computers to Thumbnail View 

�� Select the required computer/computers in the Main Window
�� Click the Add button at the bottom of thumbnail view 
�� The computer/computers is added to the selected tab

Note: The Cycle button at the bottom of thumbnail view cycles  
  through the thumbnails when there are more thumbnails than  
  can be viewed in the window at any one time 

Double-clicking on a thumbnail in the thumbnail view window  
  starts a Watch session on that student computer 

Right-clicking a thumbnail in the thumbnail view window gives 
you a drop-down menu containing relevant commands 
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Application Monitoring 

AB Tutor Control shows all running applications related to each student under the Applications tab in
the Main Window:

�� The application on the left of each row is the Active Application.
�� The Active Application has a Red Dotted border
�� Holding the mouse over an application will reveal its name in the pop-up window 

�� If an application has a file open, the file name will be displayed in the pop-up window 
�� Similarly, a web browser will display the URL of its current web page 

�� Right-clicking an application icon gives the teacher the option of: 

�� Closing the application -  the student will be given 5 seconds to save any open files.
After this, the application will be forcibly closed with the loss of unsaved work

�� Applying a temporary block to the application -  this will temporarily prevent the 
student from restarting the application  

Active Application 
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Policies

Policies are applied to student computers to : 

�� Block applications from running 
�� Control Internet behaviour 
�� Control access to computer drives 
�� Control access to printers  etc. 

The HP_Notebook student computer shown below has a policy applied to it.

Who Controls Policies? 

�� Policies can only be created by an Administrator
�� Policies can be applied by a Teacher
�� Policies can be cleared by a Teacher (unless set as Permanent by the administrator )

Policy Manager 

Policies are created, edited etc. using the policy manager.   

�� Select the Policies menu and choose Policy Manager

�� The Policy Manager window opens 
�� Click the Add new button
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�� The Policy Type window opens 
�� Select a policy type - in this case it is a Block Web Sites policy
�� Click Next at the bottom of the dialog box 

�� The Policy Name dialog box opens 
�� The policy name is added in the top field  -  in this case the name is Bebo
�� There is an option to add a button to the Tool bar.  You can choose a button from the 

drop-down list and add text for the button, if required.
�� The policy duration is next.  This can be for a Specific Time, or Permanent.  If this is 

required for a class period etc, choose specific time. In this case, it is being applied on a 
permanent basis. 

�� Click Next
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�� The Policy Time window opens.  As it is a permanent policy in this case, the dialog box is 
left unchanged.  It can be edited for periods of time when the policy is Active or Inactive

�� Click Next

�� The Block Web Sites dialog box opens.
�� Leave the Allow access to All sites radio button ticked
�� Click the Add button

�� The Add/Modify Web Link box opens. 
�� Enter the URL of the site you want to block  -  in this case it is www.bebo.com
�� Click OK
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�� The Block Web Sites dialog box returns. 
�� The Add button can be clicked again and more sites added to the blocked list
�� Click Finish when you are finished adding sites 

�� The Policy is added to the Policy Manager
�� Click OK to close the Policy Manager 

�� This procedure is repeated to create the required policies.
�� The completed policies can be exported as a file and imported into other tutor

installations policy managers 
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Applying Policies 

�� In the Main Window, select the required student computer/computers  
�� Click the drop-down list beside the Policy button in the Tool bar.
�� Choose the policy you want to set from the drop-down list  -  in this case  - Bebo

�� The HP_Notebook student computer fails to connect to the www.bebo.com web site 
�� The permanent policy applies to the computer and it effects all users who log on to it. 

Clearing Policies 

�� In then Main Window, select the required student computer/computers  
�� Click the drop-down list beside the Policy button in the Tool bar, or 
�� Select the Policies menu and choose Clear Policies
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�� The Clear Policies dialog box opens 
�� Select the policy you want to clear  -  in this case  - Bebo
�� Click OK

�� The policy is cleared from the student computer. 

�� It is also possible to Clear All Policies from the drop-down menus, if none have been set as 
Permanent by the Administrator

Policy Categories 

�� Block Internet Access:  No Internet access allowed 
�� Block Web Sites:   Block specified web sites 
�� Block Applications:   Control what applications can be run  
�� Block USB, DVD etc:   Block access to selected drives 
�� Block Printers:    Block access to selected printers  
�� Video Capture:    Record a student screen 
�� Keyboard Monitoring:  Monitor keystrokes & report set keywords, if typed  
�� Enable Privacy:    Informs the student/students if the teacher is watching 
�� Enable Logging:   Log application use, web use etc 
�� Mute Sound:    Mute the sound on student computers  
�� Lock Computer:   Screen locks at a specific preset time etc. 
�� System Action:    Any of five systems actions set to execute at a specific 

      preset time  -  Log off, Reboot, Shutdown, Launch  
      Application and Close Application   


